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Chicago Manual of Style Formatting in
Microsoft Word 2021 for Apple Products

This handout explains the procedures for formatting a Chicago Manual of Style (CMS) paper in
Microsoft Word for Apple products. Microsoft Word programs on both Apple and Windows
computers serve the same function and utilize the same tools. However, the various tools in
Microsoft Word are found in different locations within the Apple version as compared to the
Windows version.

For guidance on the rules of CMS citations, please see the Chicago Manual of Style Citation Guide
handout on the Academic Center for Excellence website.

To begin a project if Microsoft Word appears on the desktop:
If Microsoft Word is already on the dock or desktop, click the icon to open it.

To begin a project if Microsoft Word is not on the desktop:
1. Open the “Finder” program, which shows all the files and applications
on an Apple computer.
2. Inthe Finder window, type “Microsoft Word” in the Search bar to look

for the application. Make sure the search criteria is set to “This Mac.”
3. Double-click the application icon for “Microsoft Word” to open it.
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The following steps detail how to use Microsoft Word to format a CMS document.
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Chicago Manual of Style Formatting Guide:

Navigate to specific sections of this handout by clicking the links below.

Step 1: Choosing Font Style and Size — p.3

Step 2: Setting the Margins — p.4

Step 3: Adjusting the Line Spacing — p.4

Step 4: Removing the Extra Space after the Paragraph — p.5

Step 5: Inserting a Page Number — p.6

Step 6: Creating a Title Page — p.8

Step 7: Indenting the Paragraphs — p.8

Step 8: Creating a References Page — p.9

Step 9: Adding Footnotes — p.11

Additional Resources — p.14
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Step 1: Choosing Font Style and Size
Although Chicago Manual of Style does not require a specific font, Times New Roman is

recommended. On the “Home” ribbon, click on the font drop-down menu (the small arrow
next to the name of the font) to show available fonts.
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Scroll down and select “Times New Roman” or one of the other accepted CMS fonts (see
other CMS resources). You can also begin typing in the font name in the text box to narrow

——

down the list.

Times New Roman >  Times New Roman
Tiro Bangla > it

Tiro Devanagari Hindi > Talic

Tiro Devanagari Marathi > Bold

Tiro Devanagari Sanskrit > Bold Italic

Tiro Gurmukhi >

*Note: There are options listed under certain fonts, such as bold and italic, but selecting
the first option of the font name will change the font without bolding or italicizing it.

Locate the box next to your Times New Roman font, which should display a number. The
default font size may already be set to 12. If not, use the drop-down menu to select font
size 12 for the document.
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Step 2: Setting the Margins
Margins are often set to one inch by default. To set one-inch margins, click on the tab

labeled “Layout.” Click the “Margins” icon. Next, select the “Normal” setting.
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Step 3: Adjusting the Line Spacing
On the “Home” ribbon, select the “Line Spacing” icon (two blue arrows pointing up and

down next to four horizontal lines). On the drop-down menu, select “2.0” for double

spacing.
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Step 4: Removing the Extra Space After the Paragraph
On the “Home” ribbon, select the “Line Spacing” icon again. At the bottom of the drop-
down menu, select “Line Spacing Options...”
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Line Spacing Options...

Add Space Before Paragraph
Remove Space After Paragraph

When the Paragraph dialog box appears, check the box for “Don’t add space between
paragraphs of the same style” in the “Spacing” area, if it is not already checked. Then click
the “OK” button.

Spacing

Before: O pt

Line spacing: Multiple At: <

After: 8 pt S

Don't add space between paragraphs of the same style
Snap to grid when document grid is defined

Sample Text Sample Text Sample Text Sample Text Sample Text Sample Text Sample Text Sample Text
Sample Text Sample Text Sample Text Sample Text Sample Text Sample Text Sample Text Sample Text
Sample Text Sample Text Sample Text Sample Text Sample Text

Tabs... Set As Default Cancel m
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Step 5: Inserting a Page Number

Page numbers in Chicago Manual of Style start on the first page with text (i.e. not the title
page). To insert a page number, click on the tab labeled “Insert.” Click on the “Page
Number” icon and select “Page Number” again. /

[
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[7 Format Page Numbers... |

@( Remove Page Numbers

In the pop-up menu, select “Top of Page (Header).” Make sure that the “Alignment” is set to
“Right” and that the checkbox for “Show number on first page” is NOT checked. Then select
the “Format” button.

Page Numbers

Position:

Top of page (Header) :
Alighment: —

Right -

Show number on first page

Format... Cancel

——
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In the new pop-up menu, under “Page numbering,” select the option “Start at:” and replace
the 1 in the text box with 0. Hit “OK” to return to the original menu, and then “OK” again to
apply your changes.

Page Number Format

Number format: = 1, 2, 3, ...

Include chapter number

- (hyphen)

Page numbering

Continue from previous SBV
© Start at: E 2

Cancel

After adjusting these settings, a gray “1” should appear in the top right corner of the second

\
N\

€ 1

page. Double-click the top of the page to open the Header editor.

Header

Highlight the page number by double-clicking it. Next, change the font and font size to the
ones you chose earlier, following Steps 1 and 2. Then double-click outside of the header to
close it.
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Step 6: Creating a Title Page
After all the page specifications are set, the next step is to create the title page. Press the
“Return” key until you are about 1/3 of the way down the page. Next, under the “Home”
ribbon, select the “Center Text” alignment icon to center the title horizontally. Type the title

of your essay. If the paper has a subtitle, hit “Return” to start a new line and type it below
the title.
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To create the identification information, keep the text alignment centered and press “Return”
until the cursor is several lines below the title. Using the “Line Spacing” icon again, make sure
that the line spacing option is now set to single-spaced (1.0). Type the student’s name, the
course information, and the due date, pressing the “Return” key after each entry.
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Step 7: Indenting the Paragraphs
After completing the title page, hold “Command” and press “Return” on the keyboard to
start a new page for the body of the essay. Before writing the paragraphs of the essay, type
the title of the paper again, and make sure it is centered.

Select the “Align Text Left” icon to move the cursor to the left side of the page.
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Use the “Line Spacing” icon to return to double-spacing (2.0).

=visvEv == (4]0
S===|B8| ¢-=.

1.0

115
\ 15

v 20

The beginning of each new paragraph should be indented. Click the “Tab” key on the
keyboard before the beginning of each paragraph, or the “Increase Indent” icon on the

“Home” ribbon, to indent them by 0.5 inches. Do not add an additional indent if new
paragraphs are indented automatically.
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Step 8: Creating a References Page
To create a References page, a page break needs to be inserted. First, hit the “Return” key
to move the cursor to a new line. Next, click the “Insert” tab and the “Page Break” icon. A
page break can also be inserted using the “Command+Return” hotkey (see Step 9).

T
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Once the page break has been inserted, click on the “Home” tab Mailings Review
and click the “Center Text” icon. Type the title (“References” for ~ § e -
Author-Date style, “Bibliography” for Notes and Bibliography style) N R
and hit the “Return” key three times. Then align the text back to = —
the left. e
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Enter the citations single-spaced with an additional space between entries. (See other CMS
resources for a guide.) Highlight the full list of citations and move your cursor to the menu
bar at the top of the computer screen. Under “Format,” select “Paragraph...”

Help

‘ Word File Edit View Insert Format Tools Table Window
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Works Cited

S—— | ist of citations

Format Tools Table Window

« Font...

Text Effects... __F_-—-"

Paragraph... 4

Document... E

Bullets and Numbering...

In the pop-up Paragraph settings window, click the “Special” tab within the “Indentation”
section. In the drop-down menu, select “Hanging.” Make sure the box beside it indicates
“0.5” inches. Then click “OK” to close the pop-up window. This will apply a hanging indent

to all of your selected citations.
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Paragraph

Indents and Spacing @ Line and Page Breaks

General
Alignment: = Left

Outline Level: Body Text

Indentation

Left

Right: 0"

<>

Special:| Hanging By:] 0.5"

<> K>

Mirror Indents

Automatically adjust right indent when document grid is defined

With the citations highlighted, use the “Line Spacing” icon in the “Home” tab again and

select “1.0” to apply single-spacing to the citations. Press “Return” after each citation to add
an extra space between citations.
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Step 9: Adding Footnotes
If you are required to use the “Notes and Bibliography” version of Chicago Manual of Style,
you will need to use footnotes. They are not used in Author-Date CMS papers. At the end of
each sentence that requires a footnote, you must select “References” and then click on
“Insert Footnote.” This will add a superscript number 1 after the sentence. These numbers
should proceed chronologically throughout the document as more footnotes are added.
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Home Insert Draw Design Layout References Mailings Review View
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Sentence in body paragraph that uses information from the first source.’

In addition to adding a superscript number at the point you selected, using “Insert
Footnote” will automatically start a new footnote at the bottom of the page. Type the
complete citation for the source as it appears on the References page. Repeat this for each
source used in your paper, using abbreviated footnotes any time a source is used two or
more times (see CMS formatting guides).

Highlight your full list of footnotes and open the Paragraph settings that you used to create
a hanging indent (see Step 8). This time, however, under “Special,” select “First Line,” and in
the “By:” box, type “0.5” followed by “OK.”

Paragraph

Indents and Spacing @ Line and Page Breaks

General
Alignment: = Left

Outline Level: Body Text

Indentation \ \

Left:
Special:| First line By: 0.5" S

Right: 0"

<>

<>

Mirror Indents
Automatically adjust right indent when document grid is defined

This will indent the first line of each of your footnote citations by half an inch. Similarly to
the References page, citations should be single-spaced with an extra space between them.
Make sure they match the font style and size of the rest of the paper.
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=== 1. Citation for first source. The text should be single-spaced, with an extra space between
citations. On an Apple computer, this is separate from the footer of the page.

2. Citation for second source.

The number label for your footnotes should be the same font and size as the rest of the
footnote. If the “Insert Footnote” tool creates a small/superscript number in front of your
footnote citation, you can use the “Format Painter” tool to fix it. To work with the “Format

Painter,” select any text with the format you want, such as the text of your citation.

Z

' Citation for first source. The text should be single-spaced, with an extra space between
citations. On an Apple computer, this is separate from the footer of the page.

2 Citation for second source.

Click the “Format Painter” tool under the “Home” tab, which resembles a paintbrush, and

then highlight the footnote number to apply the copied formatting.

Home I Insert Draw Design

&Dv c& Times New... v | 12
15

Paste < B I v ab X,

1. Citation for first source. The text should be single-spaced, with an extra space between
Wms. On an Apple computer, this is separate from the footer of the page.

2. Citation for second source.

Make sure the font of the number matches the font of the citation and add a period.
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Additional Resources

For more information about the Chicago Manual of Style (CMS), please see the following
handouts by Germanna’s Academic Center for Excellence:

e Chicago Manual of Style (CMS) Paper Checklist for College Writers

e Chicago Manual of Style Citation Guide

e CMS Format Guide: Notes & Bibliography Style

For a visual reference of a CMS-formatted paper, please see the following handouts:
e Chicago Author-Date Style Sample Paper

e Chicago Notes & Bibliography Sample Paper
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